Galaxy Custom Designer - Quick Startup

- Schematic Editor
- Simulation and Analysis Environment

- CosmoScope
- HSPICE Toolbox for MATLAB
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1. Setting Up the Workspace

Create a working directory
mkdir ~/ee406/s14/analog/

Enter the workng directory:
cd ~/ee406/s14/analog/

Setup the libraries by creating a file lib.defs in the working directory

The file should look as follows:

INCLUDE $SYNOPSYS_CUSTOM_INSTALL/samples/lib.defs

DEFINE SAED_PDK _90 /usr/synopsys/SAED_PDK90nm/SAED_PDK_90/
DEFINE reference /usr/synopsys/SAED_PDK90nm/reference

2. Running custom designer:

From the working directory:
cdesigner &

X! 0 Custom Designer Console

File Edit View Tools Options Window Help SYNnoprsys
&b e B ®
Custom Designer (TM) Version H-2013.03-SP2-1 =

Build (OPT) Config 2337181 compiled on Thu Oct 3 16:01:49 2013 for RHEL32 4.0 U
Invocation: /fusr/synopsys/customdesigner/H-2013.03-SP2-1/linux/platform/bin/cdesi
Execution time: Tue Nov 26 13:41:32 2013

Host: synopsys-vm.gonzaga.edu

Copyright @ 2004-2013 Synopsys, Inc. ALl rights reserved.
Your use of this program is subject to the terms and conditions of the written 11

FHR R

PDK Name : SAED_PDKS0O
PDK Release Date : 29-07-2013
PDK Created Build : F-2011.09-SP2

B R A R A A A A i

SAED PDK 90: Loaded callbacks
SAED PDK 90: Loaded display resources
SAED PDK 90: Re-Created link for pcell code

4 . o

Output | History | Errors/Warnings |
Designer> ||

3. Creating a new Library
From the custom designer console:
File > New - Library
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SAED_POK 90

ache Directol /home/talarico/eed406/s14/analog |

PDararm

arlay Directory: |/home/talarico/eed406/s14/analog |

4. Creating a New Cell

From the custom designer console
File > New - Cell
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X| New CellView

[v Show Cell Categories

Libraries /|21 | Cell Categories / | |Cells /| | Views !
SAED_PDK_90 CS_state

analogLib Uncategorized schematic
basic

eed06Lib
reference ;|

Cell Name: [cs_ee114

View Name: | schematic |

Editor: |Schematic Editor LI
[v Open on Create

Help | Defaults |v| OK Apply | Cancel |

The schematic editor (SE) opens.
Enter the schematic of the design, by adding the various instances, wires, wire
names, etc.:
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X| Add Instance

Library: | analogLib |
Cell: | res |

View: [ symbol ~] @lv

Names: | [~ Expand

=

- 7 Placement Options

Cols/Rows: |1 3: |1 3: Angle: |Any Angle ~|

- 7 Parameters

Prompt Value |2

Resistance 1k Oh...

Temperature Coefficient 1

Temperature Coefficient 2

Multiplier

Model Name

AC Resistance

Temp Difference

Width

Length

Scale Factor Ll

Help | Hide | Defaults |v| Cancel

Save the design (Design = Save) often and make sure to check it for possible errors
(Design = Check and Save).

Once the schematic is finished and passes all checks (see the custom explorer
console) it can be printed, exported as an image, exported as a netlist, etc.
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Design = Print Submit (print to file)

8 00 X Print
Main | Options

—Source

¢ Current Viewport ¢~ Current Design ¢~ Other Design Depth: |0 3:

v Show Cell Categories

Libraries / Cell Categories / Cells £ | | Views / |
SAED_PDK_90 CS_state

analoglLib ‘. Uncategorized cs_new e
basic

reference

sample

sheets
snpsDefTechLib
verilogalib

—Destination

defaultPS vI Copies:ll E

v Print to File |ee406Lib_cs_ee114_schematic.ps (=] |

—Page Format Margins

Orientation: IAutomatlc vl Top: IT i Erti i ,057 i

Paper Size: ILetter vI
I~ Double-Sided Left: IO.S in Right: |0.5 in

Help | Defaults |v| Previewl Print | Cancel |
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vdc=1.08817
acm=1

VDD VB

VIN

gnd!

R
B
idc=250u r=10k
Mn
r=20k nmos4
RIN VDD
vdc=5
gnd!
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Design = Export Image (format jpeg; do not include background)

X| Export Image

—Source
¢ Current Viewport ¢~ Current Design ¢~ Other Design

v Show Cell Categories

Depth: IAII 3:

Libraries / Cell Categories [

SAED_PDK_90
analogLib

basic

reference
sample

sheets
snpsDefTechLib
verilogalib

Uncategorized cs_new

Cells / Views /
CS_state

—Destination

File: |ee406Lib_cs_ee114_schematic.jpeg

Format: IJPEG vl

—Appearance

Display: Idisplay I
OLP Group: INONE I

Color Mode: & Color
¢ Grayscale
¢ Black & White

[~ Include Background

Help | Defaults |v|

Export Cancel
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Design = Export Netlist

N Export Netlist

Netlister Format: I HSPICE vI

Main | Netlister Options |

—Design to Netlist

Library: | ee406Lib

Cell: [ cs_eel14

View: |schematic |

0@ )

Netlist file: [ee406Lib_cs_eelld.sp

—Hierarchy Options

View Search List: |cmos.sch cmos_sch schematic veriloga

View Stop List: |hspice hspiceD veriloga
[~ Flatten Design

Help I Defaults |v| OK Apply Cancel

cat ee406Lib_cs_eel14.sp

*Custom Designer (TM) Version H-2013.03-SP2-1
*Mon Nov 25 10:58:00 2013

.GLOBAL gnd!

Skk sk >k sk sk ok sk sk sk sk ok sk sk sk sk sk sk ok sk sk sk sk sk sk sk sk sk sk sk ok sk sk sk sk sk sk sk sk sk sk sk sk sk sk sk sk sksk sk sk ok skok sk sk sk ko sksk sk sk sk skok skok sk skok skok skok sk ok
* Library : ee406Lib

* Cell :cs_eellsd

*View : schematic

* View Search List : hspice hspiceD cmos.sch cmos_sch schematic veriloga

* View Stop List : hspice hspiceD veriloga

Skk sk >k sk sk ok sk sk sk sk sk sk sk sk sk sk sk ok sk sk sk sk sk sk sk sk sk sk sk ok sk sk sk sk sk sk ok sk sk sk sk sk sk sk sk sk sk sksk sk sk ok skok sk sk sk skok skok sk sk sk skok skosk sk skok skok skosk sk >k
.subckt cs_eel114

ib vdd dn dc=250u

rin gn in r=20k

r vb dn r=10k

mn dn gn gnd! gnd! nmos4 w=40u l=1.6u

vb vb gnd! dc=2.5

vdd vdd gnd! dc=5

vin in gnd! dc=1.08817 ac=1

.ends cs_eell14
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5. Running the Simulation and Analysis Environment (SAE)

From the schematic Editor invoke Tools = SAE.
The SAE window opens.

X! 5 Custom Designer SAE - ee406Lib/cs_eell4/schematic
Session Setup Variables Outputs Simulation Results Tools Window > SYN0OPSYS

| an & &|| state:

]

Status: Ready... HSPICE [~ History |1O 3: X
Variable / Value Analysis | Type | En Value 2k
temp 25 o
Click to add &
3

Variable Set: Idefault vI =
5[

Outputs | Specifications |
QOutput / Expression Analyses | Value |43 H
Click to ...
Lol

L

Output Set: Idefault vl Plotting Mode: |[replace j From IC vl Plot

Set up the model files to be used by the simulator

Setup = Model files
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O 00O |X| Model Files - ee406Lib/cs_ee114/schematic

/home/taIanco/ee406lsl4/analoglhspucemod l_

F
ER T S
EN —

Setup where to save the simulation:

Setup - Simulator

ONON®) [X\| Simulator - ee406Lib/cs_ee114/schematic

Simulator: |HSPICE ~ ~|
: [Jnomeftalarico/ee406/s14/analog/simulations [T

Save the location of the result directory in simu.xml (Defaults = Save)

Setup the analysis to run:

Setup = Analysis
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Set up your favorite HSPICE options:

Simulation = options

X| HSPICE Global Simulation Options - ee406Lib/cs_eel14/sch...

Category: |Formatting and Output Control 3
Filter: |
Name [ Local | Value Sim Default |
- Netlist Parser Control
- ALTCC O O yes
- ALTCHK O O yes
- DIAGNOSTIC O yes
--NOMOD no
B Output Listing Control
- ACCT O 1 yes
- AUTOSTOP O 0 yes
- BRIEF O O yes
- CAPTAB O O yes
- DCCAP O O yes
- INGOLD O Engineering (0) yes
- LENNAM O 16 yes
- LIST O None (0) yes
- NODE O 0 yes
- NUMDGT O 4 yes
= MEAS Options
- MEASDGT O 4 yes
- MEASFILE O O yes
- MEASOUT O O yes
----- PUTMEAS O yes
- BIASCHK Options
- BIASINTERVAL O 0 yes
- BIASNODE O O yes
- BIASPARALLEL O O yes
- BIAWARN O O yes
Help | Defaults |v| OK Apply Cancel

.OPTION NOMOD =1
This option suppresses the printout of model parameters.

Run the simulation
Simulation = Netlist and Run

Analyzing the results of the simulation:

Annotating the schematic with the DC voltages:
Results & Annotate = DC node Voltages
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VDD VB

converge Ov 5 B converge Ov 25 R
idc=250u
r=10k
2.50001
2.50001
_5 Mn
9 2.500077 nmosl114
9}1088]7 w=40u v v
~ = 0 converge 0v5 [converge Ov 2.5
108817 5 I=1.6u VoD VB
2 vdc=5 vdc=2.5
vdc=1.08817
acm=1 0
0 0
gnd! gnd!
Annotating the schematic with the DC Operating point values:
Results & Annotate = DC Operating Point
VDD VB
converge Ov 5 ib converge Ov 2.5 r
i=-1.26694n
v=-12.6694u

250001 & pwr=16.0515f
2.50001

N
E mn
> 2.5000 id=0.249999m
vgs=1.08817 v
converge Ov5 converge Ov2.5
1.08817 = =
§ § vdd vb
v=108817 vin - - v v=z5
= pwr=0 i=(n/a) i=(n/a)
i=0 0 pwr=(n/a) pwr=(n/a)
0 0
gnd! gnd! gnd!

Plotting the frequency response of the amplifier
Results = Plot Signal = AC Bode
Click on the node of interest in the schematic

Custom waveView opens
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|X| Custom WaveView Version H-2013.03-SP2 Copyright 2000-2013 Synopsys, Inc.  Expiration date : 17-jul-2014

1 k 1001 1
BE[v(/dn)] hspice.acO G740 : : " H H . T ¥
oy \iﬁ ------------------ S S e Nl

o s e e e e — N\

B [v(/dn)] hspice.acO Ty

150+

frequency(Hz) (log

Page 16 of 37



To change the default color of the background:

Config = Preferences

N Preference Settings

General | Readers Waveviewl Panel | Signals | Colors I Threshold

Waveview Background : ¢ Black & White
Grid Brightness : & Normal  Low
Cycle Color Per : ¢ Panel " Waveview
Left Button Default : ' Zoom ¢ Cursor
XY-Panel Drop Mode : ' Both ¢ Vertical

' Panel+Waveview

¢ Horizontal

Canvas Operations
[V Realtime Waveform Window Panning

™ Limit Slide-Bar Grip to Bar Region

[V Limit Phase of Complex Value between (-180,180)
[~ Extend Analog Signal Waveform to Fill X Range
[V Extend Logic Signal Waveform to Fill X Range

I~ Show Waveform X-Y Value Near Mouse Pointer
v Display Logic Glitch (time-overlapped changes)
[~ Add H-Cursor with Add-Cursor Control Button

[V Enable Cursor Snap to Logic Value Change

[~ Signal Mode By Default

[~ Enable Panel Selection Under Signal Mode

Unit Scale Factor For Monitor: auto

« Ok

Apply-Savel X Cancel

To save the preferences for future use click on Apply-Save:

X| Preference Save Location

" User Home Directory
" Working Directory
& User-Defined Path

Save to : |/home/talarico/ee406/s 14/analog/.spxrc

(=] Browse

Save

X Cancel

To change the thickness and color of waveforms:

Config - Waveform Attributes
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X| Waveform Attribu...

[~ Auto Attribute

Line Color: | j
Line Widith: Thick |
Dash Type: —_— _j
Marker Shape: O j
Marker Frequency: |0

[~ Incremental Color

* keep this window open and click over
signal name to make change

s Help X Close

Make sure to click over the signal names to make the change happen.
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Measuring the gain and the BW of the designed amplifier:

Tools 2 Measurements

- Duty Cycle

-- Slew Rate

- Delay

- Overshoot

- Undershoot

- Settle Time
- Frequency Domain
- Lowpass

-- Highpass

- Stopband

-- Gain Margin
- Phase Margin
[=)- Statistics

. Mean

- Std_dev

-~ Mean-3std_dev
- Yield

- Dpu

- Cpk

= Level

- Mean+3std_dev

E

B B

- General

- Width

- Difference

- Data(X,Y)
-Y Range

- Length

- Time Domain

- Rise/Fall Time
- Frequency

- Jitter

- Duty Cycle

- Slew Rate

- Delay

- Overshoot

- Undershoot

- Settle Time
requency Domain

m..

=-F

- Highpass
-+ Stopband
-- Gain Margin

|»

|

X| Measurement Tool

no user-defined option

[~ Show Favorites Only

Add to Favorites |

“s Help I X Close |

« Ok O Apply I

X| Measurement Tool

— Topline

Topline: [100.00 [V Percentage |~ Auto Detect

—For Percentage Lock Level, Use Min/Max Y Levels From

' Target Signal " All Signals " User Specified
Max: |3A3 Min: lO
—Offset
Offset: |~3
[V Show Topline

[ Show Topline+Offset Line

I~ Show Favorites Only

Add to Favorites |

“s Help | X Close |

« Ok O Apply |
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Computing the BW using the equation Builder of Custom Explorer WaveView

Results = Plot Signal = AC Magnitude
Click on the node of interest in the schematic
Custom waveView opens

Tools = Equation Builder
Right Click on the signal name - Add to Equation

X! Mixed-Signal Equation Builder

dcgain = ymax(‘xlmag(v(/dn))'){ = |7.48889
1 2 3 ( ) Math | RF | Wfm  Meas | Logic | Macrol
mean risetrig  snr_f xmin
4 5 6 " % median_val rmsval stddev
overshoot settling_t thd ymin
7 8 9 El @® paramvalue slewrate variance yvalue
honic_freq peak2peak slope X_at_ymax
0 ’ | G phase_m  sndr x_at_ymin
risetime snr xmax
(] ]
Equation | Measure | Macrol
Name |Result Equation Tl
- dcgain 7.48889 ymax(x|mag(v(/dn))’ IE
X
9|
=
B
>>
Plot/Close “s Help X Close
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X| Mixed-Signal Equation Builder

gainat3db=dcgain/sqn(2)|

= |s.2954s

1 2 3 + ( ) Math | RF | Wfm  Meas | Logic | Macrol
mean risetrig  snr_f Xmin
g2 5 6 - " % median_val rmsval stddev ymax
overshoot settling_t thd ymin
7| 8| 9| X| E| ® paramvalue slewrate variance
nonic_freq peak2peak slope X_at_ymax
0 ' [ | =] € phase_m  sndr x_at_ymin
risetime snr xmax
( [
Equation | Measure | Macro |
Name Result Equation
~-dcgain  7.48889 ymax(x|mag(v(/dn)))

o

... gainat3db 5.29545

dcgain/sqrt(2)

|@’ |IiJ |® |x |§1 =

Plot/Close “s Help X Close

Finally set a cursor at 5.29545 to find out the value of the BW (about 26.2 MHx)

Axes > Cursor = Jump Settings
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X! Cursor Jump Parameters

==

arc
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|X| Custom WaveView Version H-2013.03-SP2 Copyright 2000-2013 Synopsys, Inc.  Expiration date : 17-jul-2014

B[mag(v(/
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Setting up the results to output through the SAE output section
Outputs = Select in design (click on the schematics’ net(s) of interest)

Defining names for the observed outputs; creating expressions through the calculator,
plotting the results

X\ 2 Custom Designer SAE - ee406Lib/cs_eel1l4/schematic
Session Setup Variables Outputs Simulation Results Tools Window Help SYNOPSYS

“ R & & “State: CS_state
——
Status: Simulation Completed HSPICE [~ History |10 3: X
Variable / Value Analysis | Type | En | Value | Y
temp 25 »ac ac Sweep Variable: Frequency (Hz) i
Click to add - op op Format: All a
&
-
&
Variable Set: Idefault vl
Outputs | Specifications | £e
Output / | Expression Analyses | Value |w |m I a
BW bw3db(v(/dn)) 26.1119M
dcgaindb |ymax(db20(v(/dn))) ac 17.4884
vout v(/dn) &
Click to ...
Output Set: Idefault vl Plotting Mode: [replace ~| From |Current Run | Plot |

Saving the simulation and analysis setting

Session = Save State.
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1a J

States Directory: | | |

[~ Change simulator to HSPICI

I~ Change circuit to ee406Lib/cs_e /schematic

v Include Files

¥ Measurement Summary [v Stimulus
v Models v Sweeps
v Monte Carlo v

Exporting the Waveforms data for MATLAB
Go to the Custom Explorer WaveView window and click on the signals to export.

File > Export Waveform Data
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OO0  [X Waveform Export Parameters

~/eed406/s14/matlab/CS.m | | ] Browse

|| ,‘—"‘J'/-_;D;i'_'-r)-_::'/':lﬁ | |
| 1—!&0 PWL Slew : | |

Hierarchical Delimiter:

Convert Bus Al#] to

| Support Spectre Netlist Format

VCD timescale; [auto I
I <, He | ance

Page 26 of 37



Using CosmosScope to view the simulation results

The spice netlist generated by SAE is saved in:

~/ee406/s14/analog/simulations/ee406Lib/cs_ee114/schematic/HSPICE/nominal/netlist/input.spi

* Generated for: HSPICE
.option search="'/home/talarico/ee406/s14/analog/hspicemod’

.option PARHIER = LOCAL
.option NOMOD =1
.option ARTIST=2 PSF=2
temp 25

include 'ee114_hspice.sp'

.GLOBAL gnd!

ib vdd dn dc=250u

r vb dn r=10k

rin gn net18 r=20k

mn dn gn gnd! gnd! nmos114 w=40u I=1.6u
vb vb gnd! dc=2.5

vdd vdd gnd! dc=5

vin net18 gnd! dc=1.08817 ac=1

.ac DEC 100 1 100Meg
Oop All0
.option opfile=1 split_dp=1

.end

[t is important to understand what the various options mean:

.option PARHIER = LOCAL
Use this option to specify scoping rules

.OPTION NOMOD =1
This option suppresses the printout of model parameters.

.option ARTIST=2

Enables the Virtuoso® Analog Design Environment if ARTIST=2. This option is
generally used together with .OPTION PSF.

.option PSF=2

If .option PSF=2, HSPICE produces ASCII output
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.option opfile=1
Use this option to output the operating point information to a file.
e Ifvalueis 1, operating point information is output to a file named
<design>.dp#.
e Ifvalueis 0, the operating point information outputs to stdout

The results of the simulation are put in:
~/ee406/s14/analog/simulations/ee406Lib/cs_ee114/schematic/HSPICE /nominal/results

The HSPICE results produced by SAE are not in the correct format to be viewed with
Cosmoscope

In order to use Cosmoscope as viewer we need to overwrite the .option ARTIST=2

PSF=2 with .option POST.

.option artist=2 psf=2
.option post

and re-run HSPICE simulation manually.

For convenience name the new “hacked” spice netlist input.sp:

.option search="'/home/talarico/ee406/s14/analog/hspicemod’

.option PARHIER = LOCAL
.option NOMOD =1

.option ARTIST=2 PSF=2

.option POST * added by Claudio

temp 25

include 'ee114_hspice.sp'

*Custom Designer (TM) Version H-2013.03-SP2-1
*Wed Nov 27 11:43:47 2013

.GLOBAL gnd!

ib vdd dn dc=250u

rin gn net18 r=20k

r vb dn r=10k

mn dn gn gnd! gnd! nmos114 w=40u I=1.6u
vb vb gnd! dc=2.5

vdd vdd gnd! dc=5

vin net18 gnd! dc=1.08817 ac=1
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.ac DEC100 1 100Meg
Oop All0
.option opfile=1 split_dp=1

.end

make a copy of the runSimulation script:

cp runSimulation runSimulationH

and modify it as follows:

hspice -i input.sp -o ../results/Hhspice >../results/run.log 2>&1

Run the “hacked” spice simulation:
./JrunSimulationH

and move to the result directory:
cd ../results/

Invoke cosmoScope:
cscope &
File & Open Plot Files

Double click on Hhspice.acO
Select the signal to plot and click on the plot button.
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File Edit Graph Signal Axis Tools Window Help

CosmosScope (TM)

A Graph0

Graph0

¢/ Signal Manager

File Plotfile Signals Help

Signal filter | Open Protfiles...

Plotfiles Close Plotfiles

(1) Hhspice.ac0 Display Plotfiles
_ Mawhal_|
/ Close

1=

¢/ (1) Hhspice.ac0
File Signal

Filter(delim=";") li ﬂ
Y

i(vh)
i{vdd)
i(vin)
v({0)
v(gn)
v(net18)
v(vh)
v(vdd)

(N I R T I R T I

7

I

~

X Axis: T Set | Default|
Plot | Match | Deselect | Close !

o/ *C

ZIe AN

@ CosmosScope

Change the color and thickness of the waveform (right click on the name of the signal
and edit the attributes), edit the title of the graph (click on the title and edit it), add
measurements to the plot (click on Tools > Measurement Tool and then select the
type of measurement you are interested in), etc.

... Make sure to change the background !!

Graph - Color Map - Map 2
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O 00 CosmosScope (TM)

Maxirmum: 17.488

fLow: 26.111meg

The plots can be printed or exported as images.
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File = Export Image

BBl [X| Export Image

Maximum: 17.488

fLow: 26.111meg
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File & Print

BabBaB [X| Print

TNnie|

JCOn!
jconic
gnome<

gqnomes pnvate

Before Printing make sure the printer is setup correctly:

File = Printer = Setup
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BlaBlf [X| Print Setup

Maximum: 17.488

fLow: 26.111meg

The colors can be further customized: Edit = Preferences = Graph
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Using Matlab to import HSPICE simulations.

Setup a directory for the matlab files:
mkdir ~/ee406/s14/matlab

We will use the HSPICE toolbox for MATLAB developed by M. Perrott. The HSPICE
toolbox for Matlab is a collection of Matlab functions that allow you to manipulate and
view signals generated by HSPICE simulations directly.

The toolbox files are located at:
Jusr/local/ MATLAB/personal /HspiceToolbox

Note: the toolbox requires the HSPICE outputs to be in the format generated through
the POST option.

There are many functions in the toolbox, but we will focus mainly on three of them.
See hspice_toolbox.pdf for more details.

1.

loadsig (...)

This function loads the circuit signals into MATLAB. It takes the hspice output
file, such as DC (*.sw0) or AC (*.ac0) files as the function input. For example, if
you simulated a common source amplifier in HSPICE and have CS.ac0 as the
output file, the function call is:

x = loadsig(‘CS.ac0’);

Issig(...) - This function lists the signals contained in the file loaded by the
loadsig(...) function. Continuing with the above example, this function is called
as:

Issig(x);

evalsig(..., ...) - This function actually loads the signals from the HSPICE output
file into vectors in MATLAB. For example, if have a signal called v_dn, the
function is called as follows:

vout = evalsig(x, ‘'v_dn’)

Once you have loaded a signal into a MATLAB vector, you can then proceed to do any
mathematical manipulations on the data.
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MATLAB example:

%
% author: C. Talarico
% file: cad.m

clear all; close all; clc;
addpath('/usr/local/MATLAB/personal /HspiceToolbox')
X =
loadsig('/home/talarico/ee406/s14/analog/simulations/ee406Lib/cs_ee114/schem
atic/HSPICE /nominal/results/Hhspice.ac0")

Issig(x)

vout = evalsig(x,'v_dn');

freq = evalsig(x,'HERTZ');

mag = abs(vout);

phase = angle(vout); % phase in rad

magdb = 20*log10(mag);

degree = phase.*180/pi;

subplot(2,1,1);

set(gca, 'fontsize’,14);
semilogx(freq*1e-6,magdb,'linewidth’,2,'color’, 'b’, 'linestyle’,'-");
ylabel('Magnitude [dB]', 'fontsize', 12);

xlabel('freq [MHz]', 'fontsize', 12);

maxdb = max(magdb) + 5;

axis([min(freq*le-6) max(freq*1le-6) 0 maxdb]);

% compute DC gain and f3dB

format shorte;

gain = magdb(1);

idx = find(magdb < gain - 3, 1, 'first');
f3db = 1le-6*freq(idx);

% annotate the plot with DC gain and f3dB

str0 = sprintf('CS Frequency Response');

strl = sprintf('DC gain = %.2f [dB]’, gain);

str2 = sprintf('f3db = %.2f [MHz]', f3db);

str = {str0, strl, str2}; % distribute the string on three lines
title(str, 'fontsize’, 16);

g3db = gain-3;

% annotate the f3db point with "template lines"

% horizontal line

line([min(le-6*freq) le-6*freq(idx)], [g3db g3db], 'linestyle’, "', ...

'linewidth’, 3, 'color’, 'r");
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%vertical line
line([f3db f3db], [-20 g3db], 'linestyle’, "', ...

LI D |

'linewidth’, 3, 'color’, 'r");

subplot(2,1,2);

set(gca, 'fontsize’,14);
semilogx(1le-6*freq,degree,'linewidth’,2,'color’, 'm’, 'linestyle’,’-");
ylabel('Angle [degree]’, 'fontsize’, 14);

xlabel('freq [MHz]', 'fontsize', 14);

CS Frequency Response
DC gain = 17.49 [dB]
f3db = 26.30 [MHZz]

B oof :
Q it i ey
'c -
210} \
5 M
] 3
E 0 1 1 1
107° 107 107 10° 10°
freq [MHZz]
@ 500
o \
(]
S, 100}
©
(@))
c O I
< 40 107 1072 10° 10°
freq [MHz]

Page 37 of 37




